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CHAPTER 1 
INTRODUCTION, 

AVOIDANCEMONITOR II DESCRIPTION, 
SOFTWARE & HARDWARE INSTALLATION 

1.1  Introduction 
Congratulations on your purchase of an AvoidanceMonitor II system and thank 
you for choosing Kinder Scientific for your behavioral testing needs. 

Figure 1-1.  AS1000 AvoidanceMonitor Station 
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NOTE 
If you have purchased the Avoidance/SmartFrame/AGate 
Shock Option, the software installation instructions in this 
chapter and the software are the same for both systems.  
However, the hardware description and interconnect 
diagram in this chapter do not apply to the 
Avoidance/SmartFrame/AGate Shock Option.  Refer to the 
Option documentation. 

1.2  AvoidanceMonitor II Description 
AvoidanceMonitor II has been designed to put data in your hands as quickly as 
possible.  Default settings, Templates, file storage, and user definable output 
files have all been designed with flexibility and keystroke reduction in mind.  
Detailed explanations for these features are provided later, but first let’s look at 
the basic steps of running the system. 

Basic Steps: 

1. Fill in session information screen. 

2. Run the data collection session. 

3. Reduce the collected data for export. 

Once you have learned how to set up the system, it’s that simple. 
 
The manual is divided into two chapters as follows: 

Chapter 1 – Introduction, AvoidanceMonitor II Description, and 
Software & Hardware Installation. 

Chapter 2 – Getting Started. 
 

AvoidanceMonitor II records animal responses with a dedicated 
microprocessor.  The collected data is then transmitted via serial communication 
to the host PC. 
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1.3  Software Installation 

NOTE 
You must have administrator privileges to install the 
software. 

1.3.1  System Requirements 

• Microsoft Windows XP Pro, or Microsoft Windows 7 Pro. 
• Dual Core processor minimum 
• 8 GB RAM. 
• 100GB Hard drive. 
• At least one available serial COMM port on the PC. 
• 19inch Monitor with 1280x1024 resolution. 

NOTE 
- Serial to USB adapters are not supported. 

- System must have screen savers and Anti-Virus 
programs disabled during data collection. 

- Auto updates and other software applications 
must not be run during data collection. 

- System power saving settings must be set to 
ensure there is no interruption of hard drive during 
data collection. 
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1.3.2  Installation Preparation 

• Close all programs and turn off virus protection software to prevent 
installation conflicts. 

• If you are upgrading from an earlier version of AvoidanceMonitor, 
you must uninstall the earlier version using the Add/Remove 
Program feature in the Control Panel for Windows XP Pro or 
Programs and Features in the Control Panel for Windows 7 
Pro.  Existing session files, configuration files, data files, etc., will not 
be affected by uninstall. 
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1.3.3  Installation 

1. Insert the provided AvoidanceMonitor II installation CD into the CD-
ROM drive.  Access the CD-ROM, then click on AVInstall.exe.  The 
following screen will appear. 

 

2. The installation uses an AUTORUN feature and will open the following 
Screen: 

 

You will need to call or email Kinder 
Scientific to obtain a license key.  
However, you need to install the 
software first so write down the 
phone number, click OK and continue 
with the installation instructions.  The 
email address is:
service@kinderscientific.com

Click Next

Software build number
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The following screen will appear: 

 

Read through the License Agreement and click on I Agree.  The following 
screen will appear: 

 

 

Click I Agree

Click Install
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The installation is complete.  Click Finish and the installation screens will 
close. 

3. When you click on the AvoidanceMonitor icon the following screen will 
appear.  Call or email Kinder Scientific to obtain the license key. 

 
4. The following screen will appear: 

 

 

 

Click Finish

Enter the License Key 
here then click on 
OK.

Customer service at Kinder 
Scientific needs this number to 
generate the License Key.  Write 
this number down and include 
with the email.  The email is: 
service@kinderscientific.com
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5. The following screen will appear: 

 
6. After you clicked the radio button described in the previous illustration, 

the following screen will appear: 

 
 

Click on this 
radio button

Click Yes
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7. The following screen will appear: 

 

Click on the X

Click Yes
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8. The Access Admin screen will appear.  This screen is where users’ 
login information is created and maintained.  Refer to the following 
illustration and the instructions that follow on the next page to assign 
access control and permissions. 

 

 

New button

Access Control 
Entry Fields 
and Check 
Boxes

OK button

Edit button

No Save button

Delete button

Clear Password button

Save button

Password Timeout fieldUpdate button

1

2 3

4

5

6

7

89 10
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1 Start by clicking on the New button.  The Access Control entry fields 
and the permissions check boxes will be activated. 

2 Enter a login name in the Login: entry field.  The next two fields, 
Name: and Description: are optional.  However, an entry must be made in 
the Login: entry field to continue. 
The check boxes are used to assign permissions for specific tasks to each 
user.  This allows you to customize access for each user.  At least one box 
must be checked to continue. 

3 Once the field entries are made and the boxes are checked, click the 
Save button.  The user login name will move to the large field on the right 
of the screen.  Additional entries can be made by repeating the previous three 
steps as many times as needed. 

4 The Edit button is used to modify a user’s permissions.  This is 
accomplished by clicking on the user’s name and then clicking on the Edit 
button.  The user’s information will appear in the Access Control entry fields 
and the check boxes. 

5 The No Save button is used to remove information from the Access 
Control entry fields and check boxes before you click Save. 

6 The Delete button is used to delete users.  Click on the user’s login 
name then click on Delete. 

7 The Clear Password button is used to clear a user’s password.  Click 
on the user’s login name then click on Clear Password. 

8 The Password Timeout field is used to define how long a user’s 
password is good.  Enter a value in this field before you click on the Save 
button.  The default value is 90 days.  If a value of zero is entered the 
password will not timeout. 

9 The Update button is used to update your license key as previously 
described in this section. 

10 Click on the OK button when all entries are made to your satisfaction.  
This screen can be accessed at any time by opening up StartleMonitor and 
selecting Access Admin from the File menu. 
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9. After you have followed the instructions in the previous illustration, the 

following screen will appear: 

 

 
 

10. Once you have clicked No, the AvoidanceMonitor software will close.  
Clock the AvoidanceMonitor icon to re-open the AvoidanceMonitor 
software and follow the instructions in the next illustration: 

 

Click No



AvoidanceMonitor II Users Manual      Chapter 1 Introduction 
 

Version 4.14 1-13 
 

 

 

 
 

Click here and 
this happens

1. Password structure:
a. Must contain at least one special character. 

For example: !, @, #, $, %, ^, &,*
b. Must contain both letters and numbers.
c. Must be at least 8 characters.
d. Must contain at least 1 capital letter.

Create a password 
using the 

instructions below.
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1.3.4  Resetting a User Password After Expiration 

1. Login as Admin.  You do not need a password if you are a Windows 
Administrator.  Open up AvoidanceMonitor, access the File menu and 
select Access Admin.  The following screen will appear: 

 

 

2. Highlight the user you want to reset and click on Clear Password.  The 
user will be asked to set a new password at the next usage. 
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1.4  Hardware Assembly and Installation 
The following paragraphs describe how to assemble and setup the hardware, and 
how to connect to the host pc. 

1.5  Unpacking the Hardware 
Use care when removing the hardware from its shipping container to prevent 
damage to any protruding connectors, controls, or indicators.  Although the 
components are thoroughly inspected mechanically and electrically before 
packing for shipment, they must be inspected upon receipt for damage in transit. 

1. Make sure each item on the packing list is included with the shipment. 

2. Inspect all items for dents, chips and heavy scratches (gouges).  Check for 
broken or bent connectors, controls, and indicators.  Photographs of 
damage may be helpful in substantiating subsequent claims.  Kinder 
Scientific insures all shipments for damage. 

1.6  Reshipment Procedure 
If a component is to be reshipped after receipt, use of the original shipping 
container and packing materials is recommended. 

1.7  Returned Equipment With Warranty or Damage Claims 
If a component is damaged in transit you MUST contact the carrier immediately.  
DO NOT discard the shipping containers as they will be evaluated by the carrier. 
Your shipment was insured by Kinder Scientific and should be covered for any 
damage it received in transit.   

If the product does not operate as specified when received, notify the carrier and 
Kinder Scientific customer service immediately by calling 1-858-679-1515.  
Make sure you get a Service Work Order (SWO) number prior to returning any 
equipment.  Make sure you include the SWO number, your company's name, 
address, person to contact, and telephone number on the feedback form.  A short 
description of the damage or problem will also be helpful. 
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1.8  Equipment Description 
The features of the AvoidanceMonitor systems are as follows: 

A separate Control Chassis providing the interface between the host 
computer and the AvoidanceMonitor station.  Up to eight stations can 
be connected to a single Control Chassis. 

An AvoidanceMonitor Station with a Service Pack located on the left 
side of the station.  The Service Pack contains most of the station 
controls and electronics. 

Separate power supplies for the Control Chassis and the 
AvoidanceMonitor Station. 

1.8.1  BSC100 Control Chassis  As with all Kinder Scientific systems, the 
Control Chassis has its own separate embedded microprocessor controller.  This 
architecture provides a stable partition between the data collection effort and the 
host pc.  This greatly enhances the process of real-time data collection within the 
Windows platform.  Communication between the BSC100 Control Chassis’ 
embedded controller and the pc’s Windows platform is via an RS232 serial port. 

Each BSC100 Control Chassis is capable of monitoring up to eight stations 
using a single pc.  An example of the AvoidanceMonitor Control Chassis front 
panel is shown in Figure 1-2. 

Figure 1-2.  BSC100 Control Chassis  
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1.8.2  AS1000 AvoidanceMonitor II Station  The AS1000 
AvoidanceMonitor II Station is completely self-contained.  Figures 1-3, 1-4 and 
1-5 and Tables 1-1 and 1-2 provide brief descriptions of the components and 
features of the AvoidanceMonitor System. 

Figure 1-3.  AS1000 AvoidanceMonitor Station Description 

Figure 1-4. AS1000 Photo Beam Indicators 
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Table 1-1.  AS1000 Features and Components 
 NAME TYPE FUNCTION 

1. Stainless Animal Arena Easy to Clean Stainless 
Steel enclosure 

Left/ Right Test subject 
enclosure. 

2. Removable Grid Floor 
and Refuse Tray 

Removable Stainless 
Steel Insert 

When active, used to shock 
test subject. 
Unconditioned Stimulus 

3. Cue Lights  Conditioned Stimulus 
4. House Lights 30-LED array, variable 

intensity (white) 
Conditioned Stimulus 

5. Pure Tone Cues Speakers Conditioned Stimulus 
6. Front Panel Controls Controller Contains the controls and 

most of the electronics for 
the system. 

7. Optional Video Camera 
Mounts 

 Used as a visual aid to 
monitor test subject’s 
movements/reactions. 

 Gate (not pictured, 
located in the middle of 
the arena) 

Electro-Mechanical, 
software controlled 

Opens and closes to 
allow/inhibit movement of the 
test subject. 

 Photo Beam Indicators 
(Figure 1-4) 

LED Indicators (green) Lights when corresponding 
photo beam is broken by test 
subject. 
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1.8.2.1  AS1000 Front-Panel Controls and Indicators  The AS1000 
Front Panel contains the controls and most of the electronics for the 
AvoidanceMonitor System.  Figure 1-5 and Table 1-2 describes the front-panel 
controls and indicators. 

 

Figure 1-5.  AS1000 Front-Panel Controls and Indicators 

1 2
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5
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Table 1-2.  AS1000 Front-Panel Controls & Indicators  
 NAME TYPE FUNCTION 

1. Shock Current Display Display, LCD Displays status, grid current 
in mA, and Mode. 

2. SHOCK STATUS, A B LED Indicators Displays active grid 
3. START Button Pushbutton, Momentary Starts a session. 
4.  Manual SHOCK ON B 

(LEFT) A (RIGHT) 
Initiates 

Pushbutton, Momentary 
Toggle Command. Push 
to Start, Push to Stop 

Shock:  Manually activate left 
or right shock grid 
 

5. HOUSE LIGHT 
BRIGHTNESS 

Potentiometer, 
10-turn Vernier 
Dial 

Simultaneously adjusts 
house lamp intensity in both 
arenas. 

6. GRID TEST Pushbutton, Momentary Initiates the grid leak test 
7. BEAM ENABLE Two 8 Position Single 

throw Digi-Switches 
Enables/Disables beams for 
entry trigger point 

8. REMOTE/LOCAL Pushbutton, Momentary Toggles Shocker between 
Local and Remote (used for 
Grid Leak test) 

9. CURRENT SET Potentiometer Used to adjust current when 
the SHOCK ON switch is 
held in the Set position. 

10. Option Switch 4 Position Single Throw 
Digi-Switch  

For future use 

11.  A/B SELECT Pushbutton, Momentary Selects A or B side for 
setting the shock value. Each 
side is set separately 

12. TONE LEVEL, RIGHT 
LEFT 

10 Turn Potentiometers Left/Right Sound level adjust 
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Table 1-3.  AvoidanceMonitor Specifications 
 
Electrical  

Voltage: 
Frequency: 
PhotoBeams: 

100-240 Vac  
47-63 Hz 
Infrared, 8 per side 

Physical  
Depth (Overall): 
Depth (Each Side): 
Width (Overall):  
Width (Each Arena): 
Height: 
Weight 
Maximum number of stations: 
Computer Interface: 

18" (45.72 cm) 
8.75” (22.23 cm) 
27.25" (69.22 cm) 
9.25” (23.5 cm) 
10" (25.4 cm) 
50.5 lbs 
16 
Single RS232 serial port regardless of the number of stations. 

1.9  Hardware Assembly & Interconnection 
The AvoidanceMonitor system ships complete with all hardware required for 
assembly.  Each AvoidanceMonitor system will have the following hardware: 
 

The AS1000 AvoidanceMonitor station 
1 AS1000 power supply with a power cord 
1 BSC100 Control Chassis 
1 Control Chassis power supply with a power cord 
1 I/O cable  
1 serial cable 

 

1.9.1  Assembly 

1. The AvoidanceMonitor station is shipped completely assembled and only 
requires interconnection and configuration. 

2. Make sure the surface where the AvoidanceMonitor station is placed is 
clean and free of any debris. 
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1.9.2  Interconnection 

NOTE 
Refer to Figure 1-6 while performing the system 
interconnection. 

 

Figure 1-6.  AS1000 Interconnect Diagram 

1. First, make sure all power is turned off before making any connections. 

2. Connect the serial cable from the host pc to the serial connector located 
on the BSC100 Control Chassis labeled COMM PORT. 

3. Connect the I/O cable from the BSC100 Control Chassis to the connector 
located on the rear of the AS1000 Avoidance Station, starting with 
Control Chassis connector number 1. 
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4. Connect any subsequent I/O cables to their respective Stations. 

5. Once all of the cable connections have been made connect the power 
supply to the BSC100 Control Chassis and to the power source. 

6. Connect the power supply to the connector located on the rear of the 
AS1000 and to the power source.  If additional AS1000 Stations are 
installed, each Station will have its own power supply.  Make sure these 
power supplies are connected and plugged into the power source as well. 

7. If the video option is installed, connect the video power supply to the 
Video Power connection located on the back of the AS1000 Station.  
Connect the two Video Out cables to the monitor.  The Video Out 
connections are located next to the Video Power connection. 

NOTE 
The monitor should be capable of split-screen viewing 
with two Video-In connections.  

8. Turn on the computer and all the power supplies (each power supply has 
its own on/off switch).  Make sure the POWER indicator on the AS1000 
is ON. 

9. Once the computer is up and running, enable the AvoidanceMonitor 
software and then proceed to the next chapter. 
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CHAPTER 2 
GETTING STARTED 

2.1  Introduction 
The first thing you will see once the AvoidanceMonitor program is enabled is a 
screen similar to Figure 2-1. 

Figure 2-1.  AvoidanceMonitor Opening Screen. 

NOTE 
If you have purchased the Avoidance/SmartFrame/AGate 
Shock Option, the software instructions in this chapter are 
the same for both systems.  However, the Grid Leak Test 
instructions for the Shock Option are found in the DSCK 
Dual Programmable Shocker User’s Manual. 
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2.1.1  Setting the Comm Port  You must select a Comm port in order for the 
software to communicate with the hardware you just installed.  Setting the 
Comm Port is accomplished using the Setup pull-down menu.  Click on Setup 
then Comm Port.  Select a Comm Port and Click OK.  This is shown in Figure 
2-2. 

 

Figure 2-2.  Selecting the Comm Port 

2.1.2  Checking Communications  Use the following procedure to make 
sure the software is communicating with the hardware. 

1. Select the View menu, then click on Diagnostic.  If there is a 
communications failure, a screen similar to Figure 2-3 will appear.  If 
there is no failure, a screen similar to Figure 2-4 will appear. 

 

 

 

 

 First, select 
Comm Port from the Setup menu.  
Next, highlight the 
Comm port and click on 
Select. Lastly, click on OK.
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Diagnostic Communications Failure Indication 

 

Figure 2-3.  Diagnostic Communications Failure Screen 

What this screen indicates is a failed attempt to communicate with the scanner.  
If you get this screen, check the following: 

1. Make sure the RS232 cable that connects the PC to the BSC100 Chassis 
is properly connected. 

2. Make sure the BSC100 Chassis power supply is connected and turned 
on. 

3. Make sure the AS1000 power supply is connected and turned on.   

4. If the power strip the power supplies are plugged into has an on/off 
switch, make sure it’s turned on and there is power to the power strip. 
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5. Make sure a Comm Port is selected (Figure 2-2). 

6. A visual indication that the problem is rectified will be a display similar 
to the one shown in Figure 2-4. 

Figure 2-4.  Diagnostic Screen Showing Normal Communication 
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2.1.3  Setting Default Files/Folders  You can accept the installation default 
locations where the system stores the raw data files and the reduced files, or you 
can change them.  To do this, click on Setup and then Default Files/Folder 
as shown in Figure 2-5. 

 

Figure 2-5.  Default Files/Folders Screen 

 

The Default Application Folder setting determines where the raw data files 
will be stored and where session files are saved. 

The Optional Auxiliary Data Storage Folder is used as a redundancy 
storage site and may be set to any path, including any desired network drives. 

The Delimited Output Files setting determines where the system will store 
all reduced files.  It can be set to any valid path. 

NOTE 
These three default file/folderlocation selections do not 
include CD drives. 

Select Default Files/Folder from the Setup
menu to open up this screen.

Browse buttons
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2.1.4  Setting the Default Settings  The Default Settings screen is a 
keystroke reduction feature that allows you to create your own default session 
parameters.  Most of the settings on this screen are duplicates of the settings that 
appear on the session screens.  Selections made from this screen will be 
reflected on the appropriate session screens; i.e., you can pre-select and pre-fill 
specific parameters from this screen before starting a session.  This is 
particularly helpful if you are repeatedly creating sessions with the same values. 
Select Default Settings from the Setup menu and the Default Settings 
screen will appear as shown in Figure 2-6. 

 

Figure 2-6.  Default Settings Screen 

 

2.1.4.1  Default Paradigm Group  The Default Paradigm group is for 
selecting the default paradigm that will appear when New is selected from the 
File menu.  In addition, parameters specific to one or more paradigms can be set 
in this group.  Figure 2-7 shows the relationship between this group and the 
session screens, i.e., which controls apply to which paradigm. 
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Figure 2-7.  Default Paradigm Group 
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2.1.4.1.1  Multi Trial Passive Radio Button  Used to select Multi Trial 
Passive as the default paradigm when New is selected from the File menu. 

2.1.4.1.2  Single Trial Passive Radio Button  Used to select Single Trial 
Passive as the default paradigm when New is selected from the File menu. 

2.1.4.1.3  Trials to Criterion Radio Button  Used to select Criterion as 
the default paradigm when New is selected from the File menu. 

2.1.4.1.4  Active Radio Button  Used to select Active as the default 
paradigm when New is selected from the File menu. 

2.1.4.1.5  UCS Time Field  This is a pre-fill parameter for the Single Trial 
Passive and Criterion paradigms.  Used to determine the unconditioned 
stimulus time for a trial.  Values are entered in one-tenth of a second increments  
(00.0 to 99.9 seconds). 

2.1.4.1.6  TTC Trials Field (Trials to Criterion)  This is a pre-fill parameter 
for the Criterion paradigm.  Sets the criteria for the number of consecutive  
crossings that could determine the end of the session. Values are entered in one 
trial increments  (01 to 99 trials). 

2.1.4.1.7  CS-UCS Field  This is a pre-fill parameter for the Active 
paradigm.  Used to determine the delay between conditioned stimulus and 
unconditioned stimulus.  Values are entered in one-tenth of a second increments  
(00.0 to 99.9 seconds). 

2.1.4.1.8  Passive UCS Delay Field  This is a pre-fill parameter for the 
Multi Trial Passive, Single Trial Passive, and Criterion paradigms.  Used 
to determine the delay before the onset of the shock or air-puff stimuli.  Values 
are entered in one-tenth of a second increments  (0.0 to 9.9 seconds). 

2.1.4.1.9 CS-Trial Length   This pre-fill parameter for the Active paradigm 
detemines whether to end the trial when the subject crosses or allows the trial to 
run the full length as determined by the Trial Length setting.  
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2.1.4.2  Configuration Group  The Configuration group is used when 
there is no gate installed in the Avoidance station.  When the No Gate box is 
checked, the Close Gate At: parameters are disabled.  This box should only be 
checked if the AvoidanceMonitor is operating without the gate installed.  The 
Enclosure Type sub-group defines what types of enclosures are being used.  
If Avoidance stations are being used then the All are Avoidance Boxes radio 
button must be selected.  If the Avoidance/SmartFrame/AGate/Shock Option is 
being used then the All are Smartframes radio button must be selected.  
Figure 2-8 is an example of the Configuration group. 

Figure 2-8.  Configuration Group 

NOTE 

When using the Avoidance/SmartFrame/AGate/Shock 
Option , the No Gate box must not be checked and 
the All are Smartframes radio button must be 
selected. 

2.1.4.3  CS (Conditioned Stimulus) Group  The CS group is used for pre-
selecting the conditioned stimulus features.  Boxes checked here will also be 
checked on the session screen.  Figure 2-9 is an example of the CS group. 

Figure 2-9.  CS Group 
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2.1.4.4  UCS (Unconditioned Stimulus) Group  The UCS group is used 
for pre-selecting the unconditioned stimulus features. Boxes checked here will 
also be checked on the session screen.  Figure 2-10 is an example of the UCS 
group. 

 

 

 

Figure 2-10.  UCS Group 

2.1.4.5  Close Gate At: Group  The Close Gate At: group is used for pre-
selecting the session gate-closure functions.  Boxes checked here will also be 
checked on the session screen.  Figure 2-11 is an example of the Close Gate 
At: group. 

Figure 2-11.  Close Gate At: Group 

2.1.4.6  Reduction Group  The Reduction group is used for selecting 
whether or not you want header information included in the reduced file readout.  
Using this feature along with a .csv file extension will make the output file 
recognizable to Excel.  Figure 2-12 is an example of the Reduction group. 

Figure 2-12.  Reduction Group 

 

Four default parameters that do not appear on any of the Session File screens 
are the Both Sides check box and the Max UCS Time field in the UCS 
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group, the No Gate check box in the Configuration group, and the Always 
check box in the Close Gate At: group. 

The Both Sides check box is for enabling both shock grids.  The feature is 
designed specifically for the Active paradigm.  Occassionally the subject may 
stay half-way through the gate and foil the test. 

The Max UCS Time parameter limits the amount of shock time a subject may 
receive during any single shock event, regardless of the Session File setting.  
For example, if you set this parameter to 5 seconds the maximum shock time an 
subject will receive during any individual-punished crossing will be 5 seconds.  
The parameter is not cumulative, i.e., each time the subject enters the correct 
side the shock time counter will reset.  In other words, a subject may receive 
multiple shocks that will total more than this setting but it will not receive an 
inidividual shock experience that exceeds this setting. 

When Always is checked in the Close Gate At: group, the gate will stay 
down (closed) regardless of any other parameter settings.  This eliminates the 
“shuttle box” function of the system and allows you to use either arena as a 
conditioning enclosure. 

 

NOTE 
Unless you want the gate permanently closed, make 
sure the Always box is not checked. 
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2.2  Using Diagnostics 
To use the diagnostics click on View and then Diagnostic.  A screen similar to 
Figure 2-13 will appear. 

 

Figure 2-13.  Diagnostic Screen Description 

To use the diagnostic first select the desired station using the Station Selector 
Tab and then click on an individual stimulus to activate/deactivate.  Each click 
will toggle the status of the stimulus, i.e., turn it on or off and in the case of the 
gate move it up or down.  You can confirm operation of each feature by opening 
the top cover of the station and then by observing whether or not the selected 
action took place.  In addition, when you click on a function, the function will 
change color and remain in that condition until you click on it again.  Figure 2-
14 is an example with all the functions turned on. 

Select Diagnostic from the View menu to
open up the Diagnostic screen.

Gate Status

Right Condition Stimulus
(House Light, Cue Light, Sound & Air

Left Condition Stimulus
(House Light, Cue Light, Sound & Air

Gate Controls

Station Selector Tabs

Left Arena Right Arena

Right ShockLeft Shock
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Figure 2-14.  Diagnostic Screen With All Functions Active 
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2.3  Understanding Session Data Files 
The end goal is to collect activity data on each subject and place those data into 
Session Data files.  Session Data files contain user information such as the 
operator's name, subject number, sex, including a variety of user-entered 
information. 

A session cannot be run until a unique Session Data file is created for that 
session.  Saved Session files, user information, and the collected data are used 
when creating a Session Data file. 

A unique Session Data file is created each time a session is run and all data are 
stored in a proprietary format where the data is not readable by the user with 
non-Kinder Scientific software (i.e., raw data). 

It is this Session Data file (raw data plus the user-entered parameter settings) 
that is used when performing a file reduction.  The results of a file reduction are 
user-readable, analyzed data presented in a .csv format (comma separated 
values).  How to perform a file reduction is discussed later in this chapter. 

The default location for Session Data files is: C:\ProgramFiles\Kinder 
Scientific \Avoidance Monitor\Files.  You can use this location until you 
are familiar with all the workings of AvoidanceMonitor. 
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2.4  Creating a Test Session 
To create a new test session click on File then New.  A screen similar to Figure 
2-15 will appear. 

 

Figure 2-15.  Session Screen 

 

 

 

Click on 
File then 
New to open the 
Session Screen.
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There are four areas to make entries: 
 

1. Session Settings – Enter Acclimation time, select the Controlled 
Stimulus (Sound, House Light, Cue Light), select whether or not these 
stimuli will be taking place during acclimation (During Acclimation 
check box), and select Uncontrolled Stimulus (Shock, Air). 

2. Session Information – Enter up to four optional fields of text to 
attach to the data file. 

3. Enclosure Information – First, select a Use box for each station you 
want to activate.  Enter up to three fields per subject of text information 
to carry along with the data file. 

4. Select a Paradigm, and if applicable, enter desired ITI’s (Inter-Trial-
Intervals). Here you may enter one specific ITI that will be used 
consistently, or enter any pattern or random pattern of ITI’s. 

NOTE 

If you have more than one trial, you must enter at least 
one ITI.  As shown in Figure 2-15, the Add button has 
been pressed to activate the input screen where you 
can set the value of the next ITI. 

Once all fields are set, you can either Run a session as determined by the 
settings or you can first save the current settings as a Saved Session.  If you 
save the current settings as a Saved Session, you will be able to re-load the 
session information repeatedly and run additional sessions without the need to 
re-enter all the parameters.  To save the current settings click on File and Save 
As and give the file a unique filename for future reference. 
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Once you are satisfied with the current settings you are ready to run a session. 
Click on File and then Run.  A screen similar to Figure 2-16 will appear. 

Figure 2-16.  Initial Session Display 

 

NOTE 

The session display examples in Figures 2-16 and 2-17 
show the maximum eight stations.  Depending upon 
the number of stations you are running, your display 
can have anywhere from one to eight stations. 



AvoidanceMonitor II Users Manual      Chapter 2 Getting Started 

2-18 Version 4.14 
 

The system is now waiting for you to load subjects and press the start button for 
each enclosure.  Because each enclosure has an independent timer, you may 
press the start button on each enclosure as you place the subject.  After you have 
loaded all subjects into the enclosures and pressed the start button, your screen 
will appear similar to Figure 2-17. 

Figure 2-17.  Session in Progress Screen 

Note that there are several color indicators to help you observe the subjects as 
the session progresses.  Table 2-1 provides a brief description of what the colors 
mean. 
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The session will progress automatically and when all enclosures are completed 
the system with display the word Finished. 

Table 2-1.  Session Status Color Description 

 

 

Blue in this area indicates photo-beams are
being broken (test subject is in the specified
arena).

Gray indicates no activity.

3.  Green

1.  BLUE

2.  RED

4.  BLACK

Red in this area indicates Unconditioned
Stimulus (UCS) functions are active in the
specified arena (shock, air puff).

Gray indicates the function is inactive.

Green in this area indicates Conditioned
Stimulus (CS) functions are active in the
specified arena (cue lights, house lights,
sound).

Gray indicates the function is inactive.

Black in this area indicates the gate is down
(closed).

Gray indicates the gate is up (open).

COLOR FUNCTION INDICATION

Arena Status

UCS Status

CS Status

Gate Status

141

22

33
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2.5  Reducing Completed Session Data Files 
You can select any number of files for reduction and have the resulting data 
placed into a single file.  To do this click on the desired files in the Documents 
in list, one-at-a time, until you have all desired files highlighted and then click 
the right chevron.  This will add the selected files to the Documents to 
Reduce list.  Another way to create the list is double click each file.  Each 
double click automatically moves that file to the Documents to Reduce list.  
If you make a mistake and move a file that you actually do not want on the list, 
simply click on the file in the list and then click the left chevron.  The two 
double chevrons move all files back and fourth.  These features are described in 
Figure 2-18 and the references that follow. 

Figure 2-18.  Reduce File Selection Screen 

1

2

3

4
5

6

7

8

9
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1. Look in Folder:  This is where the source files for reduction are 
located.  If you have created multiple folders for file management 
purposes you will need to tell the software where to look for the data 
files you want to reduce.  To do this click on the browse button at the 
end of the Look in Folder field and select the appropriate path. 

2. Left/Right Single Chevrons.  Used to move single or selected files 
back and forth. 

3. Left/Right Double Chevrons.  Used to move all the files back and 
forth. 

4. Enclosure Info Filter:  This parameter allows you to select certain 
subjects by field.  This is based on the information placed in the 
Enclosure Information fields located in the Session Screen (refer to 
Figure 2-15). 

5. Reduce to Folder:  This is the output file destination.  You can direct 
the output file to any folder or drive you desire, including network 
drives.  The easiest way to do this is to use the browse button and select 
the desired folder.  This is because the path must be exact. 

6. Document Names Filter:  Enter in this field a key word or words 
specific to certain files.  Only those files containing the key word or 
words will be displayed in the Documents in list. 

7. Reduce:  This button initiates the reduce function. 

8. With Heading  Check this box if you want column names to be 
included with the reduced file. 

9. Reduced Document Name:  This is where you give the reduced file 
a name.  Remember to add the .csv extension to the file name.  You can 
send the output file to any drive and folder location your computer has 
access to, including network drives. 
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2.6  Grid Leak Test 
The purpose of the Grid Leak Test is to make sure that the AvoidanceMonitor 
grid assemblies are not contaminated.  Test subject urine and feces creates a 
film in the area between the bars and causes a reduction in current delivered to 
the test subject.  This is a very important test as it warns you that the grid 
assembly requires cleaning (Figure 2-19). 

 
Figure 2-19.  Grid Assembly Cleaning Location 

The grid leak test function makes the current set point 1/4 full scale (0.64 mA), 
and the hit criterion is 75% + 1 bit. After the test is triggered, each grid is 
scanned eight times. If there are a total of 16 or more hits over 8 scans for all 
grids, a fault is indicated.  So, two grids with a low enough resistance between 
them to pass 75% of (0.64 mA), consistently, would trigger a fault indication. 
 
When cleaning is required, clean between the grid bars with soap and water or 
run the assembly through a cage washer.  An abrasive pad helps to remove 
stubborn deposits.  Make sure everything is completely dry before use or a false 
grid leak failure may occur. 

 

Clean the areas 
between the rods as 
this is where 
contamination occurs 
that causes grid leak 
test failure. 
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The grid leak test is initiated as follows: 
1. First, press the REMOTE/LOCAL button located on the Station Service 

Pack (Figure 2-20). 
2. Make sure the bottom line on the LCD display changes from Remote to 

Local (Figure 2-21). 
3. Next, press the GRID TEST button.  This initiates the grid leak test. 
4. Once the test is completed, the LCD display will say OK or FAULT!.  

Pressing the button again stops the test. 

 
Figure 2-20.  GRID TEST and REMOTE/LOCAL Button Locations 

GRID TEST Button 
location

REMOTE/LOCAL 
Button location
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Figure 2-21.  LCD Display Examples 

 
• The grid leak test should be performed prior to performing daily use.  If a 

grid leak failure occurs at this time, clean the grid assembly before use. 

• If the station develops a grid leak fault between sessions, you should clean 
the grid assembly after two consecutive grid leak test failures. 

• If a fault indication develops during runtime, the grid assembly should be 
cleaned immediately. 

• Grid assemblies should be cleaned in a cage washer between studies. 

 

Local Mode 
Indication example

Initial LCD display 
example

Passing Grid test 
results example

Grid test failure 
indication example
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2.7  GLP Considerations 
Much consideration has been given to how Kinder Scientific products will 
service the needs of GLP level labs.  Along with a highly detailed effort to 
provide all the documentation, training and archiving needs there has also been 
an effort to build in certain features that will ultimately service the need for 21 
CFR Part 11 for the FDA.  This mandate requires GLP labs to insure the data 
files to contain audit trails, electronic signatures and much more.  To help with 
this requirement AvoidanceMonitor products have all related information stored 
in the raw data file.  The configuration used, information input, operators name 
and more are included in each raw data file. 

2.7.1 Microsoft Windows XP Pro or Win 7 Pro for GLP  
AvoidanceMonitor II was designed to run in Windows XP Pro or 7 Pro. 
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GLOSSARY 
Acclimation 
A form of reversible physiological adaptation by which an animal is able to alter its 
tolerance of environmental factors. 

Beam Break 
This is the occurrence of a photobeam pair being blocked.  The opposite of Beam 
Cleared. 

Beam Cleared 
Normal condition when there is no obstruction between the Light Emitting Diode 
(LED) and the Phototransistor.  The opposite of Beam Break. 

Conditioned Stimulus (CS) 
In classical conditioning, a stimulus, which originally does not evoke any response 
similar to the unconditioned response, but which during conditioning, acquires the 
property of eliciting this response or a similar one.  The original neutral stimulus. 

Inter-Trial-Intervals (ITI) 
A user-defined time partition used during data analysis.  Specifically, an ITI is a 
user-designated time interval between trials. 

Output Reduction File 
This file is created by funneling any variety of data files into one reduction file.  The 
resulting reduction file will then contain all the requested measures.  It is a comma-
delimited file especially set up for easy export into spreadsheets or statistical 
programs. 

Paradigm 
An example serving as a model or pattern. 

Session 
A complete data collection sequence for all enclosures listed in a single-session data 
file.  Put simply, the data collected from a single press of the start button of each 
enclosure selected for that session. 
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Session File 
A binary file containing all the header information entered by the user including 
duration, session parameters, enclosure information, and the actual data generated 
during the session. 

Session Template 
A file containing commonly used header information.  The user can create a variety 
of session template files and store them away for repeated later use.  This is a time 
saving technique to help save the user from repetitive typing of commonly used 
information.  Typically contains duration, session description, session information 
labels and data, and enclosure information labels and data. 

Unconditioned Stimulus (UCS).  
In classical conditioning, a stimulus which evokes or elicits a regular and 
measurable response (the unconditioned response). 
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